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1 INTRODUCTION 
The program WinRT60 calculates reverberation time in rooms based on knowledge of all 
absorbing structures in the room including air absorption. A verification of these calculations 
are normally performed using a measurement system comprising a loudspeaker, a microphone 
and a suitable software, such as WinMLS™, to evaluate the decay of sound in the room, see 
Figure 1-1.  
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 For the calculation of the reverberation time the user chooses between three different 
methods or formulae’s, i.e. using the classical formula of either W.C. Sabine or C.F. Eyring 

besides a newer one by H. Arau-Puchades. For 
the method by Sabine only the total absorbing 
area and the room volume need to be known, 
whereas the Arau-Puchades formula demands 
specifications of the locations of all absorbents. A 
short overview of the basic theory with formulas 
is given in Section 6.2. 
 

Figure 1-1. Sketch of a room with absorbents of 
areas S1 and S2. Loudspeaker L and microphone 
M for measurements.  

 
 The calculations are based on input of data from three different sources, which may be 
combined. The first is a database in Microsoft Excel format, containing the name, a 
description and data for each absorbing structure intended to be placed in the room. These 
data are either the absorption coefficient for the surface or the equivalent absorption area, 
where the latter applies to objects in the room such as persons, chairs etc. Secondly, the 
program can be used simultaneously with the program WinFlag, from where calculated data 
for the absorption coefficient of various structures may be pasted into WinRT60. Thirdly, 
measured reverberation times in a room may be imported, also from a Microsoft Excel file, 
and the total equivalent absorption area are used as data. This is normally intended for 
calculating the effect of adding new absorbents to a given room. 
 Some simple examples of a database are supplied with the program. However, it is 
presupposed that the user extends these databases with own data, either from measurements, 
from product specifications or from other sources. However, certain rules must be followed to 
make the database work seamlessly with the program.   
    

2 OVERVIEW 
The program main files are the following: 
• WINRT60.EXE This is the main program 
• WINRT60_2.0_HELP.PDF Help file  (this document) 
To get help during program execution it is assumed that the help file may be read, the 
computer must have the program Adobe Acrobat installed, version 4.0 or higher. Please note 
that there are several cross-references in the document, i.e. when sections and figures are 
referred to, clicking on the Section or Figure number will bring you to the item.  
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3 MAIN FEATURES 
• Calculates the reverberation time, usually denoted T60, in rooms using the formulae’s 

due to W.C. Sabine, C.F. Eyring or H. Arau-Puchades. The latter is only applicable to 
rooms of rectangular shape. 

• The calculations are based on data for the absorption coefficient for each absorbing 
surface together with the total equivalent absorption area of objects distributed in the 
room. These data are based on frequency band calculations or measurements, basically 
in one-third-octave bands but octave band data may be used as well. 

• The necessary data is either taken from a database in Microsoft Excel-format, from 
calculated results using the program WinFLAG™ or based on measured reverberation 
time data. The program is supplied with some examples of a database.  

• The absorption capability of the air in a room is often neglected but may give an 
important contribution to the total absorption. This is particularly relevant when the 
moisture content is low, i.e. in certain times of the year when the relative humidity is 
low, maybe below 20–30 %. The effect is accounted for by a calculation of the power 
attenuation coefficient of air according to ISO 9613 Part 1. From this coefficient the 
equivalent absorption area due to the air is calculated and added to the absorption of 
the other structures in the room.     

• A report window in Rich Text Format (.rtf file) is implemented where specifications 
of the room and the absorbents together with tables of results and diagrams may easily 
be imported. 

• Calculated results for the reverberation time, together with specifications of the room 
and the absorbents used, may also be exported to a Microsoft Excel file. 

• The set-up for a calculation, based on a certain selection of absorbents and specified 
data for the room, may be saved in a file and later recalled for further calculations. 

• On errors in the input data, the set-up will be displayed in a separate window, see 
section 6.7. 

 

4 CHANGES FROM VERSION 1.0 
 Changes from the first version 1.0 are: 

• The database may now contain data for the equivalent absorption areas of objects 
distributed in the room. These are not contributing to the area covered by the chosen 
absorbing structures such as porous or panel absorbers. This implies that the effect of 
persons, chairs etc. in the room may be accounted for after the proper absorption 
coefficients are applied to the room boundary surfaces. In the database such objects 
must be marked with the letters “AS”; see the database example sheet in Table 1. 

• Measured reverberation time data may be imported, again from a Microsoft Excel-file, 
to represent the basic absorbing condition of a room. The effect of adding given 
absorbing structures to the room may then be investigated. 

• The ordinate scale of all diagrams may be set to fit the data automatically.  
• A new option called “New setup” is introduced in the file menu, which retains the 

database but erases former data input.   
        

5 BRIEF DESCRIPTION OF THE PROGRAM 
The program is started either from your program menu or by clicking on the file 
WINRT60.EXE or by making a shortcut to this file and start from the desktop. The following 
window should then appear, see Figure 5-1. 
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 In the list box to the left (labelled “Absorbents in database”) the names of the various 
absorbing structures will appear when loaded from a database file, pasted from the program 
WinFLAG (version 2.1 or later) or based on measured reverberation time imported from a 
file.  First loading the database and thereafter filling in by data from WinFLAG and/or from 
the reverberation time file may combine these three sources of data. The data from the latter 
two will be added to the bottom of the list. 
 In the list box labelled “Selected absorbents” the user must assemble all the absorbing 
structures to be used in the calculation of the reverberation time. There are three possible 
ways to transfer an absorbent from the database list to the absorbents list: 1) by double-
clicking on the absorbent in the database list, 2) by marking an absorbent in the database list 
and then click on the button marked with “+” in the toolbar and 3) using the submenu “Add 
from database” under the main menu “Absorbent”. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5-1.  The calculation window at start-up time 

 
 Below these two list boxes there is a narrow list box containing the word 
“Description”. Here the short user description of the absorbent structure will appear when 
clicking on the absorbents name either in the database box or in the selection box. At the same 
time the absorption characteristic for the structure will show up in the diagram, see Figure 
5-2. Depending on the absorbent structure is a material or an object the diagram will display 
either the absorption coefficient or the equivalent absorption area.  
 The default option for calculating reverberation time is using the method of Sabine. 
The pressed button in the toolbar having an ear as an icon indicates this (Sabine used his ear 
and a stopwatch to register the decay of sound when he established his famous formula).  
 As a first example, using the formula of Sabine, we will state that our room has 
dimensions 10 by 6 by 2.5 meters, i.e. a total volume of 150 m3. There are brick walls of total 
area 30 m2 and the remaining walls, 50 m2, are plasterboard (gypsum) stud walls. Covering 
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some 25% the ceiling area is an absorbent, a perforated panel backed by 50 mm Rockwool. 
The floor absorption is for simplicity neglected. We shall, however, allow for some persons in 
the room; ten persons, each having an expected maximum absorption area. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5-2. The calculation window after a database is loaded and four different absorbing 
structures are placed in the selection box. The absorption characteristic for the selected panel 
absorbent intended for the ceiling is shown. 

 
  Figure 5-2 shows the situation when a database is loaded and, furthermore, the 
absorbent structures mentioned above are all loaded into the list box named “Selected 
absorbents”. In the latter the names are shown in grey colour indicating that the curve in the 
diagram, showing either the absorption coefficient or the equivalent absorption area, is taken 
from the database. As mentioned above, clicking on a database item defined as an object or 
also being calculated from measured reverberation time, the equivalent absorption area will 
show up in the diagram. Please note that in the latter case one may need, either to adjust the 
diagram maximum Y-value or use the auto scaling to see the result. 
 The next step is to assign the proper area (or the number) to the selected absorbents by 
clicking on each of them as shown in Figure 5-3. The database text is then shown in grey 
indicating that the information is now taken from the selection box. Here the gypsum 
(plasterboard) wall is clicked on and both the curve and the description are shown. At the 
same time the input box named “Area (m2)” is open for input of the area of the selected 
absorbent. As seen we have already input the chosen 50 m2 for this wall. In the case of 
selecting an object the label above this input box will change to “Number”. The default 
number of objects is one. 
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Figure 5-3. The calculation window at the stage of assigning areas to the selected absorbent 
materials or number of absorbing objects (here 50 m2 for a plasterboard (gypsum) wall and, 
furthermore, input of the volume of the room). 

 
 At this stage all the remaining input boxes for a Sabine calculation is of course open 
for adjustments. Please note that button named “Calculate” have appeared under the input 
boxes. Clicking on this button a calculation is performed and the calculated reverberation time 
will be shown in the diagram, see Figure 5-4. One may note that there are no calculated 
results below 125 Hz even if data for the ceiling absorbent is present down to 50 Hz. The 
reason is that there are no data below 125 Hz for the object “person”. The data for the gypsum 
wall is limited upwards to 3150 Hz, thereby limiting the reverberation time in this end also. 
 
 

5.1 CALCULATION OPTIONS 
One important option in the program is the possibility to calculate the reverberation time by 
using different methods or formulas. This option is better explained and illustrated by 
examples given in the following section.  
 After a calculation is performed a frame will appear below the diagram. Here one is 
offered the choice of having one or two curves displayed; a previous result together with the 
last calculated one. This also offers the possibility to compare results using different 
calculation methods. Marking the box “HOLD” after a calculation will keep this result for 
comparison with a later result. Unmarking the box will continually update the second curve. 
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Figure 5-4 The calculation window showing the result using the Sabine formula. 

 
 Two other options should also be mentioned in this context. On the right end of the 
toolbar there are two buttons, one with an information icon and one with a warning icon. The 
first one, when depressed, will give information concerning input when using the method by 
Arau-Puchades. The second one will give a warning when the selected absorbent covers less 
than the proper room surface area (Arau-Puchades), furthermore, when the total absorbent 
area is less that the rooms total surface area (Eyring).  
 
 

5.2 PROGRAM EXECUTION. EXAMPLES USING DIFFERENT METHODS 
As mentioned above the default calculation method is by using the simple Sabine formula, an 
example is shown in Figure 5-4. Choosing the method by Eyring, which also requires input of 
the total surface area of the room, an input box for this variable will appear below the volume 
input box. The Eyring method is chosen either by using the menu “Calculation method” or 
clicking on the button with an icon depicting a microphone.  
 Using the same data for the room as before, see section 5 above, Figure 5-5 gives the 
result applying the Eyring formula. The broken curve shows the results from the former 
calculation using the Sabine formula. As seen, the differences are not large in this case but are 
wholly dependent on the actual situation.  
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Figure 5-5. The calculation window showing the result using the Eyring formula, solid curve 
denoted “Last”, as compared with result using the Sabine formula, broken curve denoted 
“Previous”. 

 
 The third calculation method implemented is due to Arau-Puchades, see the reference 
below, a method that may be seen as a modified Eyring method. It strictly applies only to 
enclosures of rectangular shape and the intension is to take into account a non-uniformly 
distribution of absorbents, which is a normal situation in practical cases. The formula is a 
product sum of Eyring’s formula defined for the room surfaces in the three main axis 
directions, X, Y and Z, each term weighted by the relative area in these directions. For further 
details, see Section 6.2.3.     
 Using this method implies that one must first input the room surface area in these 
three directions. Secondly, the selected absorbent materials must be assigned to the proper 
surfaces. The former is implemented clicking on each of the radio buttons inside the frame 
appearing below the list boxes when choosing the Arau-Puchades method, see Figure 5-6. 
The surface area in each direction X, Y and Z is subsequently written into the input box at the 
right end of this frame. In this example the last surface input was the Z-surface having an area 
of 30 m2. The total surface area of the room is now calculated from these data and will appear 
in the box with the label “Total area (m2)”.  
 The second step is as before to input the area of the absorbent material by clicking in 
the selection box. However, one must at the same time attach or assign each selected 
absorbent material to its proper room surface. The latter is accomplished by using the small 
scroll bar inside the absorbent area frame to mark the absorbent with an X, Y or Z according 
to which surface it belongs to. When adding objects to the room, as seen here allowing for 10 
persons using a recommended maximum value for the equivalent absorption area, the label 
“Area (m2)” is changed to “Number”. These objects should again be assigned to the proper 
surface but they do not “occupy” any part of the surface area.    
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 The complete procedure, defining the surface areas of the room and assigning 
absorbents to them, is however given as information (the info button in the toolbar must be 
pressed) when selecting the Arau-Puchades method. This method is again chosen from the 
menu “Calculation method” or clicking on the toolbar button having an icon depicting a pie 
chart with three colors. 
 
NOTE: Applying the same type of absorbent to more than one plane, e.g. on two planes such 
as SX and SY, the absorbent has to be selected twice. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5-6. The calculation window showing an example using the Arau-Puchades formula, 
solid curve denoted “Last”. The broken curve denoted “Previous” gives the result for the 
empty room, i.e. when leaving out the persons.  

   
 An example using this method is shown in Figure 5-6. The broken curve shows the 
result for the empty room, i.e. leaving out the persons. Comparing the results from the 
different calculation methods one often finds that the differences are not very large. However, 
it should be pointed out that the differences are wholly dependent on the actual situation. If 
the larger surfaces of a room have a very low mean absorption coefficient the method of 
Arau-Puchades will give significantly longer reverberation time than the other methods.   
 

6 MENUS 
Most of the menus have been pointed to and used in the examples given in the preceding 
section. Below, we will explain these menus in detail and give further reference to the various 
calculation methods and the necessary input data. Most of the submenus are reflected in a 
corresponding toolbar button. 
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6.1 THE FILE MENU 
The menu contains the following submenus: 

• Open database 
• Find in database 
• Open selection 
• Save selection 
• Export results 
• Make report 
• Report window 
• New setup 
• EXIT 

 
Menu Shortcut Toolbar 

button 
Description 

 
 

Open database 

 
 

Ctrl O 

 
 

 

Opens a formerly prepared database of different 
absorbing structures and input their given names 
in the list box labelled “Absorbents in database”. 
The database must be in the Microsoft Excel 
format with extension .xls. The structure of the 
database must adhere to certain rules that are 
explained in section 6.1.1.  

 
Find in 

database 

 
Ctrl F 

 
None 

A simple search routine for an absorbent name in 
the database containing the input text. If found, 
the absorbent will be marked and the curve will 
be displayed. 

 
 

Open selection 
 

 
 

Ctrl T 

 
 

     

Opens a file with a formerly saved selection of 
absorbents, the specifications of the room and the 
calculation method used. Calculations according 
to the given selection are performed and results 
displayed.  

 
Save selection 

 
Ctrl S 

 

     

Saves all the data for a given selection of 
absorbents, the room data and the present 
calculation method to an ordinary text file 
(ASCII). The file name is given by the user with 
the extension ".sla" 

 
Export results 

 
 

 
Ctrl E 

 

     

The last calculated reverberation time data, 
together with all data for the room, are exported 
to a Microsoft standard Excel-file with the 
extension ".xls".  

 
 

Make report 

 
 

None 

 
 

None 

Hides the calculation window and opens up a 
report window with a text box (.rtf – format) in 
which the user may import set-up specifications, 
results tables and the graphical picture. A 
description is given below; see section 6.1.2. 

Report window None None Shows the current report window. Hides the 
calculation window. 

New setup None None Erases all input data except for the database list 
EXIT None None Terminates the program on confirmation 
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6.1.1 The database of absorbent structures 
As mentioned above is the necessary data for the absorption coefficients either taken from a 
database in Microsoft Excel-format and/or from calculated results using the program 
WinFLAG™. Some simple examples on databases are supplied with the program, containing 
data which the user may use preparing a proper database. The basic shape of a database is 
shown in Table 1 below. Here the various cells are marked with colours according to rules 
that must be followed, see explanation below the table. The absorbents must be numbered 
consecutively and given a name and a short description.  
Opening a database will clear any former lists (the database list and the selected 
absorbents list) and former input data.    
 

Table 1.  Example showing the database structure for absorbents 

  
WinRT60 Number 1 2 3 
Database example sheet Name Porous 50mm Perf. panel  12% (2b) Single upholstered chair 
Alpha for absorbing materials or Decription 10 kPa.s/m2 Panel + 50 mm Rockw. Adapted from EN 12354-6 
absorption area for objects Frequency (Hz) Alpha Alpha AS 
 40       
 50       
 63 0.008 0.05   
 80 0.027 0.15   
 100 0.057 0.21 0.07 
 125 0.095 0.34 0.1 
 160 0.155 0.59 0.14 
 200 0.227 0.74 0.16 
 250 0.313 0.75 0.19 
 315 0.409 0.82 0.21 
 400 0.510 0.81 0.24 
 500 0.609 0.84 0.26 
 630 0.699 0.80 0.28 
 800 0.777 0.74 0.29 
 1000 0.838 0.68 0.31 
 1250 0.882 0.69 0.32 
 1600 0.911 0.63 0.33 
 2000 0.926 0.61 0.34 
 2500 0.935 0.58 0.35 
 3150 0.943 0.50 0.35 
 4000 0.953 0.48 0.35 
 5000 0.959 0.46 0.35 
 6300 0.958     
 8000       
 10000       
     
   Do not modify!   
   Keep this form   
   Fill partly or wholly   
   Must contain "AS" when data is object absorption area, else may be left blank 
   For free use   

 
 

6.1.2 Making a report 
The menu Make report opens up a new window, see Figure 6-1 below, allowing the user to 
make a report specifying the absorbents used and the data for the room, a table of the 
calculated reverberation times and a copy of the graphical picture. In the example shown the 
Sabine calculation method is used and no graphical picture is pasted.   
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There are three menus in the report; File, Edit and View and a toolbar. Most of the submenus 
are reflected in this toolbar. The File menu has the following items 

 

 

• Open… 
• Save as… 
• Print 
• Calculation window 
• Close 

 
The first two submenus will open up the 
Microsoft standard window for opening/saving 
files. The first option is included if need be to 
use a formerly saved report file (or a text file) 
as the basis for a new report. The save option 
saves the report as an rtf-file.  
 The print option opens up a standard 
print window allowing the user to directly print 
the report on an attached printer. The user can 
process the report file in a text-processing 
program. As a consequence, the toolbar offer 
only a limited number of processing options; 
i.e. font type and aligning in addition to the 
standard cut, copy and paste. The latter items 
are also found under the Edit menu.  
 

Figure 6-1 The report window where the layer 
properties and one-third-octave results are 
imported 

 
 

 Furthermore, the submenu Calculation window will hide the report window and revert 
to the main calculation window for further calculations, the results of which may be added to 
the report. The Close option will, after confirmation, close the report window (without 
saving). 
 The Edit menu has the common options of editing (undo, cut, copy and paste) of 
which the last three is reflected in the toolbar with the Microsoft common icons. In addition 
one will find tree special paste commands:   
 

• Paste set-up data 
• Paste T60 results 
• Paste diagram 
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These commands is summarized as follows: 
 

Menu Shortcut Toolbar 
button 

Description 

 
Paste set-up 

data 

 
 

None 

 

     
 

Pastes the name, description and area for all 
absorbents used together with room data specific 
for the applied calculation method. 

 
Paste RT60 

results 

 
None 

    

     
     

 
Pastes a table of the calculated reverberation time 
T60 according to the applied calculation method.  

Paste diagram None 
     
     

Pastes the diagram currently shown in the 
calculation window. 

 
Finally, the View menu controls the toolbar and the status line. 
 
 
 

6.2 THE CALCULATION METHOD MENU 
The menu contains the following submenus: 

• Sabine 
• Eyring 
• Arau-Puchades 

 
Menu Shortcut Toolbar 

button 
Description 

 
Sabine 

 
F1 

 

 

Calculates the reverberation time according to the 
classical formula by Sabine based on the total 
absorption area in a room with a given volume V. 
For further details, see section 6.2.1 below. 

 
 

Eyring 

 
 

F2 

 
 

 

Calculates the reverberation time according to the 
formula by Eyring based on the mean absorption 
coefficient in a room with a given total surface 
area S and a volume V. For further details, see 
section 6.2.2 below. 

 
 

Arau-Puchades 

 
 

F3 

 
 

 

Calculates the reverberation time according to the 
formula by Arau-Puchades based on the mean 
absorption coefficient on room surfaces SX, SY 
and SZ, total surface area S (=SX+SY+SZ) and 
volume V. For further details, see section 6.2.3 b. 
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6.2.1 Sabine’s reverberation time formula  
This model for the reverberation time in rooms is due to W.C. Sabine (1868 – 1919) who is 
the year 1900 published his famous article “Reverberation” presenting his formula relating the 
reverberation time to the total absorbing area in a room. It is based on the assumption that the 
sound field in the room is perfectly diffuse, i.e. sound energy density is everywhere the same 
and the sound propagates with equal probability in all directions. The formula may be 
expressed as 

 6
Sa

0 0

4 55.26ln(10 ) VT
c A c A

= ⋅ ≈
V
⋅ , (1) 

 
where V and c0 is the volume of the room and the speed of sound, respectively. The total 
absorption area A of the room is given by 
 i i

i
A Sα=∑ , (2) 

where iα  is the absorption coefficient of the surface having the area Si. The sum is taken over 
all absorbing areas in the room. Despite its simplicity and the assumptions behind its 
derivation it is probably the most commonly used formula in practice. It should be noted that 
it is not usable for highly damped rooms. Even when the absorption coefficient is equal to one 
on all surfaces the reverberation time is still finite. Obviously, in such a situation the 
reverberation time must be zero.  
   

6.2.2 Eyring’s reverberation time formula 
There are a number of reverberation time formulas in the literature taking account of the fact 
that reverberation is not a continuous process but involves a stepwise reduction of the sound 
energy impacting on the various room surfaces. C. F. Eyring, see reference below, developed 
in 1930 one such formula. This may be expressed as 
 

 Ey
0

55.26
ln(1 )
VT

c S α
= ⋅

− ⋅ −
, (3) 

 
where S is the total surface area of the room and α is the average absorption coefficient, i.e. 
given by  

 1
i i

i
S

S
α α= ∑ . (4) 

 
The expression is obviously correct for totally absorbing surfaces in the room in which case 
TEy will become zero. Furthermore, for α << 1 the formula (3) will be equal to the Sabine 
formula, equation (1).  
 
Reference: 
Eyring, C. F. (1930) Reverberation Time in “Dead” Rooms. J. Acoust. Soc. Am. 1, 217 – 241. 
 

6.2.3 Arau-Puchades’ reverberation time formula 
There have been several suggestions on how to take account of non-uniformly distributed 
absorption in a room, which in fact is the normal situation in practice. The formula 
implemented in this program is due to H. Arau-Puchades, see the reference below. It applies 
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strictly to rectangular rooms only and may be considered as a product sum of Eyring’s 
formula defined for the room surfaces in the three main axis directions, X, Y and Z, each term 
weighted by the relative area in these directions. It may be expressed as 
 

 AP
0 0 0

55.26 55.26 55.26
ln(1 ) ln(1 ) ln(1 )

X YS S
S S

X Y

V VT
c S c S c Sα α

⎡ ⎤ ⎡ ⎤ ⎡
= ⋅ ⋅ ⋅ ⋅ ⋅⎢ ⎥ ⎢ ⎥ ⎢− − − − − −⎣ ⎦ ⎣ ⎦ ⎣

ZS
S

Z

V
α

⎤
⎥
⎦

. (5) 

 
Using this formula one may e.g. assign the ceiling and the floor to the area SX having the 
average absorption coefficient Xα , the two sets of sidewalls to the corresponding surface areas 
and absorption coefficients with indices Y and Z. 
 
Reference: 
Arau-Puchades, H. (1988) An Improved Reverberation Formula. Acustica 65, 163 – 180. 
 

6.2.4 The sound absorption of air 
The absorption of air should not be neglected when calculating the reverberation time in a 
room. This is a factor that normally will affect the results in the high frequency range, i.e. in 
the kHz range, and being heavily dependent on the air moisture content. The absorption, or 
what we may denote excess attenuation, is characterized by a power attenuation coefficient m 
with dimension metre-1. General data for a related coefficient α = 4.343⋅m (dB/km), given as a 
formula and also in tabular form as a function of frequency, air temperature, air pressure and 
relative humidity, is found in ISO Standard 9613 Part 1. In WinRT60 the air pressure is set 
equal to one standard atmosphere, i.e. 101325 Pa.  
 The excess attenuation will, when included into the reverberation time calculation, 
result in an added total absorption area of 4mV (m2), where V is the volume of the room. The 
added absorption area is easily included into the formula of Sabine and Eyring. Using the 
formula of Arau-Puchades a choice has been made to divide the added absorption area in 
proportion to the size of the areas SX, SY and SZ.   
 
   

6.3 THE ABSORBENT MENU 
The menu contains the following submenus: 

• Database 
 Add from WinFLAG 
 Import from RT-file 

• Selection 
 Add from database 
 Delete absorbent 

 
These submenus modify either the content of the database list box or the content of the list 
box containing the selected absorbents. Modifying the database list box is possible in two 
ways: 1) by pasting data from the program WinFLAG™ and 2) by importing measured 
reverberation time data. In the second option the Sabine’s formula is applied to calculate the 
equivalent absorption area, which is considered as the area of a single object; see further 
description below.  
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Menu Shortc
ut 

Toolbar 
button 

Description 

 
Add from 
WinFLAG 

 

 
Ctrl W 

 

 
 

An absorbent calculated using the 
program WinFLAG is pasted from the 
Clipboard into the database list box. It 
is added to the bottom of the list.  

 
 
 
 

Database  
Import from 
RT-file 
 

 
 

Ctrl R 

 

 

Measured reverberation times in a room 
are imported from a Microsoft Excel 
file and by way of Sabines formula 
converted to an equivalent absorption 
area. Data is added to the bottom of the 
list. See details in section 6.3.1.  

 
Add from 
database 

 
Ctrl D 

 

 
 

A marked absorbent in the database list 
box is copied into the list box 
containing the selected absorbents. 
Double-clicking in the database list box 
may alternatively perform this. 

 
 

Selection 
 

Delete 
absorbent 

Del 
 

A marked absorbent in the selection list 
box is deleted.  

 

6.3.1 Import of measured reverberation time data 
This option is normally intended for calculation of the effect of placing additional absorbents 
in an existing room, where the reverberation time has been measured. On the basis of the 
measured data in the file the equivalent total absorption area of the room is calculated using 
the formula of Sabine. According to the temperature and humidity data, also given in the 
measurement file, the air absorption is subtracted from the result before the “absorbent” is 
added to the bottom of the database list box. The “absorbent” is treated as a single absorbing 
object, i.e. the number of this “object” is fixed to one. Furthermore, as a remainder, the 
volume of the measurement room is added to the description of the “absorbent”. The structure 
of the input file is shown in Table 2.  
 Please note that including this type of absorbent in the list of selected absorbents, 
only the calculation method of Sabine is allowed.  
 

6.4 THE DIAGRAM MENU 
The menu offers the choice of changing the values on the axes of the diagram. No new 
calculations are performed. The choices are the following:  
 

• First frequency 
• Last frequency 
• Y minimum 
• Y maximum 
• Y auto 
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Submenu Shortcut Description 
 

First frequency 
 

None 
Opens up a window to specify the first frequency 
marking on the abscissa. The default value is 45 
Hz.  

 
Last frequency 

 
None 

Opens up a window to specify the last frequency 
marking on the abscissa. The default value is 
5700 Hz. 

Y minimum None Opens up a window to specify the minimum 
value for the ordinate. The default value is zero.  

 
Y maximum 

 
None 

Opens up a window to specify the maximum 
value for the ordinate. The default values are 1.2 
for the absorption coefficient, 1.0 (m2) for the 
equivalent absorption area and 5.0 (s) for the 
reverberation time. 

 
Y auto 

 
None 

The ordinate expands automatically to 
accommodate the data. This function is reset to 
manual adjustment of the scale by using the 
submenus Y minimum or Y maximum 

  
 

Table 2 An example showing the structure of the Microsoft Excel file for measured data 
 

WinRT60_T-data Frequency (Hz) T60 (s) 
"Absorbent" name: 40   
Absorption area from T 50 1.60 
Description 63 1.50 
Lecture room 80 1.40 
Room volume (m3): 100 1.30 

100.0 125 1.25 
Temperature (deg. C) 160 1,15 

20.0 200 1.10 
Humidity (%) 250 1.00 

50.0 315 0.95 
 400 0.86 

 500 0.80 
 630 0.80 
 800 0.80 
 1000 0.80 
 1250 0.77 
 1600 0.72 
 2000 0.70 
 2500 0.65 
 3150 0.62 
 4000 0.60 
 5000 0.55 
 6300   
 8000   
 10000   
   
   
   Do not modify! 
   Must contain data 
   Fill wholly or partly 
   For free use 
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6.5 THE HELP MENU 
The choices are:  

• Opening the full manual (pdf-file) 
• Information on WinFLAG 

 
Submenu Shortcut Description 

Manual (pdf-file) Ctrl H  Opens up this help file in pdf-format. The 
program to read this file, Adobe Acrobat, must 
be installed.  

About WinRT60 None Displays an information window on WinRT60  
 
 

6.6 THE TOOLBAR 
As seen from the descriptions of the menus above, most submenus are reflected in the buttons 
of the toolbar. The two buttons on the right end of the toolbar are exceptions here. When the 

button with the information sign, , is depressed, information on the necessary steps in the 
Arau-Puchades method is given.   

 When the button with the warning sign, , is depressed, warnings are generally 
issued (before any calculation is performed) when the selected absorbents cover less than the 
defined surface areas of the room. In this case, answering “No” when asked to proceed with 
the calculations, the set-up information window will be displayed, see section 6.7. 
 

6.7 THE SET-UP INFORMATION WINDOW 
Prior to any calculation a check will be performed on the input data, i.e. on data for the 
absorbents listed in the selection box and their match with the data for the room. Additionally, 
the match between the volume and the total surface area of the room will be checked. In the 
former case obvious errors will cause a message followed by a display of a set-up information 
window. An example is shown in Figure 6-2 below.  
 When using the Eyring’s formula this window will appear when the total area of the 
selected absorbents is larger than the total surface area of the room. Using the Arau-Puchades 
formula the same applies when absorbents are missing on either room surface X, Y or Z, or 
the total area of the selected absorbents attached to any of these surfaces is larger than the area 
of these surfaces.  
 This information window may also be displayed when a warning is issued due to a 
mismatch of the areas of the absorbents in relation to the areas for the room surface(s), i.e. the 
selected absorbents do not cover the available room surface. This action, however, depends on 

the position of the button with the warning sign, , see section 6.6 above. A warning 
message will be displayed if the button is in its depressed position, offering the choice to 
proceed with the calculations or not. In the latter case the information window will be 
displayed. 
 Please note that this window is for information only, data must be modified from 
the main calculation window.   
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Figure 6-2. The set-up information window showing data for a calculation using the method 
of Arau-Puchades. 
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7 WINRT60 LICENSE AND LICENSE TRANSFER 
Once you have registered the software, you may transfer the license from one computer to 
another. For this to work, the software has to be registered on the user's computer. Once the 
transfer is complete, the original program will become unregistered on the computer you 
transferred the license from (so it is not possible to run the software on two computers 
simultaneously).  
 
To transfer the license, the user will need the registration number from the new computer. 
You must install and run the software on this new computer to obtain the registration number. 
Then the license must be transferred: On the computer you want to transfer the license from, 
click the Start button and open the command line prompt by clicking Run…. 
 
Then type the information shown below:  
"C:\Program Files\WinRT60_20\WINRT60.EXE" /TRANSFER XXXX-XXXX-RT 
 
The first part is the full path of the WinRT60 executable (your path may not be the same as 
shown above). XXXX-XXXX-RT is the registration number from the computer you want to 
transfer the license to. 
 
After clicking the OK button in the Run dialog box, a text file is generated with the unlock 
code and user name. Use this information to register WinRT60 on the new computer. 
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